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Lesson Objectives 
 

 To edit the company chart of accounts 

 To add a new customer to the Customers & Jobs list 

 To add a new vendor to the Vendor list 

 To learn about custom fields, and to practice adding custom fields 
 
 To see how to manage lists in QuickBooks 

 

Notes 
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Using QuickBooks Lists 
 
QuickBooks lists organize a wide variety of information, including data on customers, 
vendors, inventory items, and more. Lists save you time by helping you enter information 
consistently and correctly. Such as: 
 

 Names, addresses and other information about customers 

 Contact information for vendors 

 Descriptions and prices for products and services 

 

Notes 
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Editing the Chart of Accounts 
 
The chart of accounts is your most important list because it shows how much your business 
has, how much it owes, how much money you have coming in, and how much you’re 
spending. 
  
To display the chart of accounts: 
 

1. From the Lists menu, choose Chart of Accounts. 

 
 

2. Scroll through the list.  

The Chart of accounts displays balance sheet accounts first, followed by income and 
expense accounts. 
 

Notes 
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Editing an Account 
 
To edit an account: 
 

1. In the chart of accounts, select Checking. 

2. Click the Account menu button, and then select Edit Account. 

3. In the Description field, type Great Statewide Bank. 

 

 
 

4. Click Save & Close. 

 

Notes 
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Adding a Subaccount 
 
To add a subaccount: 
 

1. In the chart of accounts, click the Account menu button and then choose New. 

QuickBooks displays the Add New Account: Choose Account Type window. 
 

2. Select Expense. 

3. Click Continue. 

4. In the Account Name field, type Trade Pubs. 

5. Select the “Subaccount of” checkbox, and then select Dues and Subscriptions. 

6. In the Description field, type Trade Publications. 

7. Click Save & Close. 

QuickBooks displays the new subaccount. 
 

 
 

8. Close the chart of accounts. 

 

Notes 
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Working with the Customers & Jobs List 
 
The Customer Center stores names, addresses, and other information about your customers. 
It also holds information about the jobs or projects you may want to track for each customer. 
 
To add new customers: 
 

1. Click Customer Center in the navigation bar. 

 
 

2. Click the New Customer & Job menu button (at the top of the Customer Center), 
and select New Customer. 

3. In the Company Name field on the Address Info tab, type Godwin Manufacturing, 
and then press Tab. 

4. In the Bill To field, click at the end of the line below the company name and press 
Enter. 

5. Type 376 Pine Street, and then press Enter. 

 

Notes 
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Working with the Customers & Jobs List 
 

6. On the next line of the Bill To field, type Bayside, OR 64326. 

7. Click Copy to have QuickBooks copy the billing address to the Ship To field. 

8. Click OK to use this address as the Ship To address. 

9. Continue filling out the customer information by providing the following information: 

 
Contact: John Godwin 
Phone: 325-555-9841 
Fax: 325-555-0012 
Alt Contact: Tracy Heldt 

 

 
 
 

Notes 
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Working with the Customers & Jobs List 
 
The Additional Info tab is where you can provide other important information, such as 
customer type (if you want to categorize your customers in some way), payment terms, and 
sales tax information. 
  
To add additional information to a customer record:  
 

1. Click the Additional Info tab. 

2. In the Type field, type Industrial. 

3. Press Tab. 

4. Click the Quick Add button to add the customer type to the list. 

5. In the Terms field, type Net 30. 

6. In the Tax Code field, select Non. 

7. In the Tax Item drop-down list, select Out of State. 

 
 

Notes 
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Working with the Customers & Jobs List 
 
The Payment Info tab is where you enter customer account numbers and credit limits. You 
can also record information about each customer’s preferred payment method. For customers 
who pay by credit card, you can enter credit card numbers and expiration dates. 
  
To add payment and credit information to a customer record:  

1. Click Payment Info. 

2. In the Credit Limit field, type 2000. 

3. In the Preferred Payment Method drop-down list, choose Check. 

 

 
 

4. Click OK to add the customer and close the New Customer window. 

5. Close the Customer Center. 

 

Notes 
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Working with the Employee Center 
 
To add a new employee: 
 

1. Click Employee Center in the navigation bar. 

 
 

2. Click New Employee at the top of the Employee Center. 

3. In the First Name field, type Marlene. 

4. In the Last Name field, type Duncalf, and then press Tab. 

5. In the SS No. field, type 123-45-6789. 

6. In the Gender field, select Female.  

 

Notes 
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Working with the Employee Center 
 

7. In the Date of Birth field, type 7/18/82. 

 
 

8. Click the Address and Contact tab. 

9. In the Address field, type 195 Spruce Avenue, #202. 

10. For the City, State, and Zip fields, type Bayshore, CA 94326. 

11. In the Phone field, type 415-555-1111. 

12. In the Change tabs field, select Employment Info. 
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Working with the Employee Center 
 

13. In the Hire Date field, type 11/26/2007. 

14. Click OK. 

15. When QuickBooks asks if you want to set up payroll information, click Leave As Is. 

QuickBooks updates and displays the Employee list with the new employee’s name 
added. 

 

 
 

16. Close the Employee Center. 

Notes 
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Working with the Vendor Center 
 
The Vendor Center is where you record information about the companies or people from 
whom you buy goods or services.  
  
To add a new vendor: 

1. Click Vendor Center in the navigation bar. 

 
 

2. Click New Vendor at the top of the Vendor Center. 

3. In the Vendor name field, type Hughes Electric. 

4. In the Company Name field, type Hughes Electric, and then press Tab. 

5. Click in the Name and Address field, after the company name displayed on the first 
line, and press Enter. 

6. On the second line of the Address field, type P.O. Box 2316.  

 

Notes 
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Working with the Vendor Center 
 

7. Press Enter to move to the next line. 

8. Type Middlefield, CA 94432. 

9. In the Contact field, type David Hughes. 

10. In the Phone field, type 510-555-6666. 

11. In the Fax field, type 510-555-6667. 

 

 
 

Notes 
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Providing Additional Vendor Information 
 
The Additional Info tab in the New Vendor window is where you can enter a vendor type (if 
you want to categorize your vendors), payment terms, your credit limit, the vendor’s tax 
identification number, whether this vendor is eligible for a 1099 form, and your opening 
balance. 
  
To add information to a vendor record: 
 

1. Click the Additional Info tab. 

2. In the Account No. field, type 123-445. 

3. In the Type field, type Subcontractors. 

4. In the Terms field, choose 2% 10 Net 30. 

5. In the Credit Limit field, type 2000 and press Tab. 

6. Click OK. 

 

 
 

7. Close the Vendor Center. 

 

Notes 
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Adding Custom Fields 
 
QuickBooks lets you add custom fields to the Customers & Jobs, Vendor, Employee, and 
Item lists. Custom fields give you a way to track additional information specific to your 
business. 
  
To add custom fields: 

1. Click Customer Center in the navigation bar. 

2. In the Customers & Jobs list, select Cook, Brian. 

3. Click the Edit Customer button. 

4. Click the Additional Info tab. 

5. Click Define Fields. 

 
 

6. In the first blank Label field, type Pager Number. 

7. Click the Customer:Jobs checkbox to select it. 

8. Click the Vendors checkbox to select it.  

 

Notes 
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Adding Custom Fields 
 

9. In the next blank Label field, type Date of last review. 

10. Click the Employees checkbox to select it. 

 
11. Click OK. 

12. If you see an informational message, click OK. 

13. In the Pager Number field, type 415-555-9876. 

14. Click OK to close the Edit Customer window. 

15. Close the Customer Center. 

Notes 
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Adding Custom Fields 
 
To add custom fields for items: 
 

1. From the Lists menu, choose Item List. 

2. In the Item list, select Lk Doorknobs. 

3. Click the Item menu button, and then choose Edit Item. 

4. Click Custom Fields. 

5. Click Define Fields. 

6. In the “Use” column, click the first blank checkbox to select it. Then type Style in the 
Label field. 

 

 
 

7. Click OK to close the window. 

8. In the “Custom Fields for Lk Doorknobs” window, type Round in the Style field. 

 

 
 

9. Click OK to close the Custom Fields for Lk Doorknobs window, and then click OK 
to close the Edit Item window. 

10. Close the Item list. 

 Notes 
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Managing Lists 
 
To sort a list manually: 
 

1. From the Lists menu, choose Chart of Accounts. 

 
 

2. Click the diamond to the left of the Owner’s Draw subaccount of Owner’s equity. 

3. Click and hold the mouse button, and drag the pointer upward until you see a dotted 
line directly below Owner’s Equity. 

4. Release the left mouse button. 

 

 
 

5. To re-sort the list alphabetically, click the Account menu button, and select Re-sort 
List. 

6. Click OK. 

7. Close the chart of accounts. 

 

Notes 
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Managing Lists 
 
To sort a list in descending order: 
 

1. Click Customer Center on the navigation bar to display the Customer Center and 
Customers & Jobs List. 

2. Click the arrow to the right of the View drop-down list to expand the Customers & 
Jobs list. 

3. Click the Balance Total column heading. 

4. Click the column heading again. 

 

 
 

5. To return to the order you started with, click the large diamond to the left of the Name 
column heading. 

6. Click the collapse arrow to the right of the window to collapse the Customers & Jobs 
list. 

7. Close the Customer Center. 

Notes 
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Managing Lists 
 
In most lists, you can combine two list items into one. For example, you may find that you’ve 
been using two customers (because of different spellings) when you really need only one on 
your Customers & Jobs list. You can merge list items in the Chart of Accounts, Item, 
Customers & Jobs, Vendor, Employee, and Other Names lists. 
  
To merge items on a list: 
 

1. From the Vendors menu, choose Vendor Center. 

2. Double-click the entry for Hughes Electric. 

3. In the Vendor Name field, type C.U. Electric. 

4. Click OK. 

5. Click Yes. 

6. Close the Vendor Center. 

 

Notes 
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Managing Lists 
 
You can rename any list item. When you make the change, QuickBooks automatically 
modifies all existing transactions containing the item. 
  
To rename a list item in the chart of accounts: 
 

1. From the Lists menu, choose Chart of Accounts to display the chart of accounts for 
Rock Castle Construction. 

2. In the chart of accounts, select Checking. 

3. Click the Account menu button, and choose Edit Account. 

4. In the Account Name field, type Master Checking Account. 

5. Click Save & Close. 

 
6. Close the chart of accounts. 

Notes 
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Managing Lists 
 
You can delete list items only if you have not used them in any transactions. If you try to 
delete a list item that is used in a transaction, QuickBooks displays a warning that the item 
can’t be deleted. If you don’t want to use a list item but you can’t delete it, you can make it 
inactive. 
  
To make a list item inactive: 
 

1. On the Home page, click the Customers button (along the left side of the Home 
page). 

2. Select Milner, Eloyse in the list. (Select her name, not the job.) 

3. Right-click the name and choose Make Customer:Job Inactive. 

4. To see inactive list items, choose All Customers from the View drop-down list. 

 
 

5. Leave the Customer Center open.  

Notes 
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Managing Lists 
 
You can print a QuickBooks list for reference, or you may print a list to a file to use in your 
word processor or spreadsheet. QuickBooks prints the Customers & Jobs list as it appears on 
the screen. For example, if the Customers & Jobs list is expanded and sorted by balance total, 
QuickBooks prints the expanded list sorted by balance total; if the list is collapsed, 
QuickBooks prints just the customer name, the balance total, and active status. 
  
To print the Customers & Jobs list: 
 

1. In the Customer Center, click the Print menu button, and then choose Customer & 
Job List. 

2. Click OK to bypass the List Reports message. 

3. Click Print. 

 

Notes 
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Managing Lists 
 
To print information on one customer: 
 

1. In the Customers & Jobs list, select the customer whose details you want to print. 

2. Click the Print menu button, and then choose Customer & Job Information. 

3. Click Print. 

 

Notes 
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Managing Lists 
 
If you want to print information for selected customers only, you can generate and filter the 
Customer Contact report for those customers. You can also modify the report to include the 
columns that you want. 
  
To print information for selected customers: 
 

1. From the Reports menu, choose List, and then choose Customer Contact List from 
the submenu. 

2. Click Modify Report. 

3. Click the Filters tab. 

4. Select Customer in the Filter list. 

5. In the Customer field, choose Multiple customers/jobs. 

6. Make sure Manual is selected then click to put a checkmark next to those customers 
for which you want to print contact information. 

7. Click OK to close the Select Customer:Job window. 

8. Click OK to close the Modify Report window. 

9. Print the report. 

 

 Notes 
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Lesson 3: Working with Lists 
 
Review questions 
 

1. How many custom fields can you set up for items? 

a 4 
b 5 
c 7 
d 20 
 

2. Which of the following forms and windows could potentially be populated with 
information from the Vendor list? 

a Purchase orders 
b Bills 
c Write Checks 
d All of the above 
 

3. Which of the following activities cannot be accessed from the Customers & Jobs list 
in the Customer Center? 

a Create statements 
b Assess finance charges 
c Enter credit card charges 
d Receive payments 
 

4. On which tab of the Edit Customer window would you enter a customer’s payment 
terms (for example, Net 30 Days)? 

a Address Info 
b Additional Info 
c Payment Info 
d Job Info 
 

5. A customer has three warehouses and you are installing an overhead door at each 
location. The best way to track this in QuickBooks would be to: 

a Set up each location as a separate customer 
b Set up a separate job for each location under the customer 
c Enter all work as one order under the customer 
d Use a custom field to track each location 
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6. Products you sell would appear on which of the following lists? 

a Vendor list 
b Employee list 
c Chart of Accounts 
d Item list 
 

7. A subcontractor would appear on which of the following lists? 

a Vendor list 
b Employee list 
c Customers & Jobs list 
d Item list 
 

8. Name at least three lists on which you can merge items. 

a ________________________________________ 
b ________________________________________ 
c ________________________________________ 
 

9. True or false: You can delete list items that are used in transactions. 

a True 
b False 
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Review activities 
 

1. Add the following customer using the data below: 

- Customer Name: Alla Rozenvasser 
- Opening Balance: $234.00 
- Company Name: Rozenvasser Advertising 
- Contact: Alla Rozenvasser 
- Bill to: 300 Main Street, Suite #3, Middlefield, CA 94432 
- Phone: 415-555-6767 
- Fax: 415-555-9090 
- Alt. Contact: Shannon Stubo 
- Type: Commercial 
- Credit Limit: $2500 
- Terms: Net 15 
- Tax Item: San Domingo 

 
2. Add a new vendor using the data below: 

- Vendor: Martin Drywall 
- Contact: Sean D. Martin 
- Address: P.O. Box 76, Middlefield, CA 94432 
- Phone: 555-5432 
- Fax: 555-6565 
- Account: 082-4343 
- Type: Subcontractors 
- Terms: Net 30 
- Credit Limit: 1,000.00 
 

3. In the Customers & Jobs list, select Ecker Designs. Answer the following questions: 

a What is the job status for Ecker Designs’ office repairs? 
b What is the number of the most recent invoice and how much was it? 
c What happened on December 11th? 
 

4. In the Vendor Center, locate sales tax payment transactions. Answer the following 
questions: 

a Who is the vendor? 
b How many payments have been made? 
c What is the total amount of payments that have been made? 
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5. In the Employee Center, find Gregg Schneider’s information.  

Answer the following questions: 

a What is the name of his spouse? 
b When was Gregg hired? 
c How many hours of vacation has Gregg used in 2007? 
d What is Gregg’s overtime pay rate? 
 

6. In the Vendor Center, find C.U. Electric. Answer the following questions: 

a What is open balance for this vendor? 
b How many bills are outstanding and what are the amounts? 
c What are the payment terms for this vendor? 
 

7. Open the Item list and answer the following questions: 

a How many brass hinges are on hand? 
b What is the price of a patio door? 
c What is the finance charge percentage on overdue balances? 
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Answers to review questions 
 

1. How many custom fields can you set up for items? 

a 4 
b 5 

c 7 
d 20 
 

2. Which of the following forms and windows could potentially be populated with 
information from the Vendor list? 

a Purchase orders 
b Bills 
c Write Checks 

d All of the above 
 

3. Which of the following activities cannot be accessed from the Customers & Jobs list 
in the Customer Center? 

a Create statements 
b Assess finance charges 
c Enter credit card charges 

d Receive payments 
 

4. On which tab of the Edit Customer window would you enter a customer’s payment 
terms (for example, Net 30 Days)? 

a Address Info 
b Additional Info 

c Payment Info 
d Job Info 
 

5. A customer has three warehouses and you are installing an overhead door at each 
location. The best way to track this in QuickBooks would be to: 

 
a Set up each location as a separate customer 
b Set up a separate job for each location under the customer 

c Enter all work as one order under the customer 
d Use a custom field to track each location 

 
6. Products you sell would appear on which of the following lists? 

a Vendor list 
b Employee list 
c Chart of Accounts 

d Item list 
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7. A subcontractor would appear on which of the following lists? 

a Vendor list 
b Employee list 
c Customers & Jobs list 
d Item list 
 

8. Name at least three lists on which you can merge items. 

a Chart of accounts 
b Item 
c Customer & Jobs 
d Vendor 
e Employee 
f Other Names 
 

9. True or false: You can delete list items that are used in transactions. 

a True 
b False 
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